Camera and Binocular Parts Guide

(A) LCD Display

(B) ON/OFF Button

(C) MENU Button

(D) 5-way Keypad w/ "Enter", Left/Right, Plus/Minus

(E) Reticle Focus

(F) Diopter Adjustment

(G) Battery Compartment

(H) Remote Jack

(I) USB Port

(J) Card Slot

(K) Binocular Focus

(L) SNAP Button

(M) Camera Lens
1) The SyncFocus is powered by two AAA batteries (not included). Insert batteries into the compartment (G), using the polarity marks inside for reference. A power meter in the lower left corner of the display indicates battery condition.

2) Insert an SD or SDHC card into slot (J) if greater storage is desired. The card will click into place. You may use SD/SDHC cards (not MMC cards) up to 32 GB capacity. If the card you insert was previously used in other devices, format it before taking photos. Press the Enter button (D) to enter Play mode, then press the MENU button (C). Press the Minus key (D) once to select “Format”, then press Enter. Note the warning that this will erase all files—make sure you have backed up any files you wanted to keep. Press the Plus key (D) to select “OK”, then press Enter to format the card. Press Enter again to exit the Play mode.

3) Raise the LCD display (A), and press the ON/OFF button (B) briefly. The camera will automatically turn itself off after two minutes of inactivity (this can be changed using the “Auto Off” option in the Setup menu).

4) To set the menu language, press the MENU button. Keep pressing the Plus or Minus key until you highlight “Language”, press Enter, then press Plus to highlight your language and press Enter. The Date/Time imprint feature is turned on by default. Press the Plus key to highlight “Clock Set” and press Enter. Now set the Year, Month, Date, Hour and Minute (in order from left to right), using the Plus/Minus keys to make changes, and the Right key to move to the next item. Once date & time are set, press the Enter button. Use “Date Stamp” to set your preference (month first, year first or off) Press Enter then Exit the menu to return to the preview display. Reset the date/time if you replace batteries.

5) Turn the reticle focus (E) until the black circle is sharp, then adjust the binocular focus (K) until your subject is sharp. Hold the camera steady with both hands and press the SNAP button (L) to take a still photo. When using a tripod, you can help avoid the effects of camera shake by plugging the supplied remote shutter release cable into the jack next to the SD card slot rather than SNAP to take photos.

6) To shoot a video, press the Right key (D) three times until the red movie camera icon appears at the top right corner of the display (see “LCD Preview Display Icons”-#10). You can then start shooting the video at any time by pressing the SNAP button.
To stop recording the video, press the SNAP button again. By default, videos are recorded as a 15 second loop (“instant replay”). To change this, press MENU—the first item is “Resolution”. Press Enter, then select “Video Size”. Use the Plus/Minus keys to select a different video resolution and frame rate combination (which determines loop length—8, 15, 30 or 60 seconds). You also have the option to select a “Norm” video setting if you prefer to shoot standard video clips, instead of loops that re-record (refresh) automatically. For more information regarding the still and video resolution options and other menu settings, please see the “Using the Main Menu” section of this manual.

7) To review or playback a still photo or video, press the Enter button. You will see the most recent still photo or video. To review previous photos or videos one at a time, press the Left key. To play back a video, press the SNAP button (press again to stop playback). To delete photos/videos, press MENU. Select Delete One (only the currently displayed photo/video) by pressing Enter, then the Plus button to select “OK”, and press Enter to delete the file. If you wish to delete all photos/videos, use the Format menu option as described earlier.

8) To download photos/videos to your PC, connect the USB cable from the SyncFocus to your computer. The SyncFocus will be recognized as a standard “USB Mass Storage” device and will appear as a “Removable Disk” under the “My Computer” list (on Macs, an icon will appear on your desktop). The photo files are located in the “DCIM” folder on this “Removable Disk”. Copy the files to your hard drive (drag or use the “copy files” option), then disconnect the camera. (On Mac computers, drag the “disk” that appeared on your desktop when the camera was connected into your Trash to “eject” it before disconnecting.) The jpg standard files from the SyncFocus may be edited with any photo software you choose to use.

NOTE: If you are not using an SD card in the SyncFocus, be sure to download all files from its internal memory before changing batteries and before storing the camera for a long period. If you use an SD card, photos may also be downloaded by removing the card and using any USB card reader with an SD slot.

Your SyncFocus camera is already set for high resolution and quality right out of the box, and it is not necessary to change any of the settings to get good results. However, many features and options are provided to enhance your enjoyment of the camera. For more information about them, please refer to the remainder of this User Manual.
BASIC SETUP

Loading Batteries
Turn the SyncFocus over, slide open the battery cover as indicated by the arrow, remove and set aside. Insert 2 AAA Alkaline or Lithium batteries into the compartment (G) in the direction indicated inside, then replace the cover, sliding it back into place until it clicks. Note: Rechargeable NiMh type batteries may also be used, but some may not deliver adequate current to power the camera and display. AAA NiMh batteries with a current rating of 850 mAh or higher are recommended.

Inserting An SD Card
The camera can store from about 15 (at 2660x1920 resolution and “Best” quality) up to over 100 photos in the internal memory, depending on resolution and quality settings. To expand the available storage, you may add an optional SD or SDHC (High Capacity) memory card, with 32GB or lower capacity. The camera will not function if a 64GB or higher capacity SD card is inserted. Do not use “MMC” cards, which look similar to SD cards. The card is inserted into the slot (J) on the back of the camera pod (pull down the rubber cover flap—please refer to the “Camera and Binocular Parts Guide” page), label side up with the “notched” corner on the right as indicated by the card icon above the slot. Note: be sure the power is turned off before inserting or removing cards to prevent possible loss of files or damage to the card. A new card will not require formatting, but a card that has been previously used in other devices (cameras, mp3 players, etc) should be formatted by the SyncFocus before you start taking photos (see the “Using the Review Menu” section for details). Note that formatting will erase all files previously stored on the card, so be sure they have been downloaded and saved on your computer first if you wish to keep them.
BASIC SETUP

Setting the Date and Time/Date Stamp Feature
You may want to go into the main options menu and set the correct date and time before beginning to take photos (or turn off the date stamp feature, as the default setting is “on”). To set date and time:
1. Raise the LCD display and press the ON/OFF (B) button.
2. Press MENU (C). Press the Minus key (D) 7 times to highlight “Clock Set”, and press the Enter button (D).
3. Now set the Year, Month, Date, Hour (24 hr format), and Minute, using the Plus/Minus keys to make changes, and the Right key (D) to move to the next field.
4. Once the date & time are set, press the Enter button.
5. Press the Minus arrow key once to highlight “Date Stamp”, press Enter, then highlight your preference using the Plus/Minus keys: Month-Day-Year format, Year-Month-Day format, or OFF (the date will not be stamped on your photos).
6. Press Enter, then press the Minus key twice to highlight “Exit”, then press Enter again to exit the menu options and return to the “live” preview display.

Auto Off (Power Save)
By default, the SyncFocus will automatically turn off if no buttons or controls have been pressed for two minutes. This helps save power and extend battery life when the camera is accidently left on. However, when you are first learning to use the camera you may want power to remain on (until you press ON/OFF) as you get familiar with the features and controls. To do this, enter the main menu as described above in “Setting the Date...”, highlight “Auto Off”, press Enter, and select “Cancel”. Press Enter, then exit the menu as described above.
Setting the Reticle Focus and Diopter Adjustment

Before you begin taking photos, a few simple, one-time adjustments should be made to ensure that you can get sharp photos of any subject by just using the main focus knob on the binoculars. This process will compensate for any variations in the eyesight or vision of the individual user:

1. Leave the rubber eyecups in their “up” position if you are not wearing glasses, or roll them down if you are. Grasp the left and right sides of the binocular, and pull them apart or push them together while looking through the binocular to adjust the eyepiece spacing until your view is a single circular image.
2. Look through just the left side of the binocular—you will see a black ring (reticle) in the center. Point the binocular at a plain, light background like the sky or a wall in your house.
3. Rotate the reticle focus (left eyecup-(E)) until the circular reticle appears as sharp as possible to your left eye. This compensates for any difference in between your vision and the correct focus for the camera.
4. Next, continuing to look through the left side only, aim at a distant object (preferably one containing fine detail such as a tree or sign), and adjust the binocular’s center focusing knob (K) until it appears as sharp as possible to your left eye.
5. Finally, view the same object through only the right side of the binocular, and rotate the diopter adjustment (right eyecup-(F)) until it appears sharp to your right eye (do not touch the center focus knob while doing this). This compensates for any vision differences between your left and right eyes.

Menu Display Language Options (English, Spanish, Italian, French, German)
The main menu also has an option to select your preferred language for all menu screens.

SYNCFOCUS SETUP (Reticle & Diopter)

Setting the Reticle Focus and Diopter Adjustment
Before you begin taking photos, a few simple, one-time adjustments should be made to ensure that you can get sharp photos of any subject by just using the main focus knob on the binoculars. This process will compensate for any variations in the eyesight or vision of the individual user:
SYNCFOCUS SETUP (Reticle & Diopter)

Once set, note the number on the left and right binocular tubes that the index mark on each eyecup is lined up with. With the reticle focus and diopter adjustment set to these positions, you should be able to get sharp photos/videos of a subject at any distance by simply adjusting the center focus knob while you look through the binocular optics. There is no need to re-adjust the reticle focus or diopter adjustment, unless you share the Syncfocus with another user, or if your eyes become tired over a long period of use.

The camera lens provides 8x magnification, which is the same power as the binocular’s optics, and it is aligned so that an object centered in the binocular will also be centered in your photos or videos. Therefore, it is not necessary to have the LCD turned on or even raised while you are shooting photos or videos. Reducing use of the LCD will extend battery life significantly.
**TAKING STILL PHOTOS**

After completing the basic and Syncfocus setups as described in the previous pages, you are ready to take a photo:

1. Raise the LCD display (A) and briefly press and release the **ON/OFF** button—the startup screen will appear, followed by the live image from the camera lens. The display also shows the battery condition, number of photos remaining, and the current setting of various options. *Please refer to “LCD Preview Display Icons” for more details.*

2. The SyncFocus will default to high resolution and quality settings, as well as “everything on automatic” when it is turned on for the first time, so you’re ready to take photos under most conditions with no need to change anything. If you’d like to explore the various available options, see the manual section titled “Using the Main Menu-Options and Settings” for directions regarding how to select and change settings such as resolution, image quality and exposure.

3. You may compose your photo while looking through the binocular (the LCD does not need to be on to take a photo). However, for the most accurate framing, checking the LCD preview display is recommended.

4. Hold the camera as steady as possible with both hands and gently press the **SNAP** button. If possible, attach the SyncFocus to a tripod and plug the supplied remote shutter cable into the remote jack (H) to obtain the steadiest results (press the button on the remote to take a photo). The display will “freeze” briefly immediately after a photo is taken—this is normal while the image is being stored in the internal or card memory.
TAKING STILL PHOTOS

5. The “remaining photos” 4-digit counter in the lower left corner of the display above the battery indicator will drop by one number after each photo (or two, depending on your subject and settings) is taken. Once it reaches “0000”, and the display indicates “Memory Full!” when SNAP is pressed, you are out of memory (storage space) and will need to download the photos you have taken so they can be deleted to make room in the memory for new photos, or you may remove the filled up card and install another SD card if you are on a trip away from your computer.

6. A digital zoom feature is available. Press the Plus arrow key to zoom in (you will see the result on the LCD, and the digital zoom indicator bar moves towards “T” for “Telephoto”). Press the Minus arrow key to zoom back out (the zoom indicator bar moves towards “W” for “Wide Angle”). To turn off all digital zoom (go back to the 8x optical magnification only) keep pressing the Minus key until the zoom bar indicator goes back fully left to “W” and disappears.

7. To review a photo after you take it, press the Enter button. To see previous photos, press the Left arrow key—each press takes you back one photo, and pressing the Right arrow key moves forward to more recent photos. Press the Enter button again to return to the live preview. See the section “Review Menu” for directions covering deleting photos, formatting internal or card memory, and protecting important photos.

NOTE: Use care during handling to avoid touching the camera lens (M), located in the center between the binocular lenses, to prevent degrading the image quality. Clean the camera lens only with dry lens tissue or microfiber cloth. DO NOT use liquids of any type.
SHOOTING VIDEOS (SETTING/USING VIDEO MODE)

To switch from still photo to video mode, press the **Right** arrow key 3 times, until the red movie camera icon is displayed at the top right area of the LCD (see “LCD Preview Display Icons”, #10). You are now in Video Mode. Press **SNAP** to start recording a new video clip, and press it again to stop recording and store the video in memory. The recording time is limited only by the amount of internal or card memory currently available. You may record a single long video until you run out of memory or multiple shorter videos by stopping and starting recording whenever you wish by pressing **SNAP**. The counter on the right side of the display shows the time elapsed since the recording was started. *Note: the video files use the .avi format.*

By default, videos are recorded as a 15 second loop (“instant replay”). To change this, press **MENU**-the first item is “Resolution”. Press **Enter**, then select “Video Size”. Use the **Plus/Minus** keys to select a different video resolution and frame rate combination (which determines loop length-8, 15, 30 or 60 seconds). You also have the option to select a “Norm” video setting if you prefer to shoot standard video clips, instead of loops that re-record (refresh) automatically. *For more information regarding the still and video resolution options and other menu settings, please see the “Using the Main Menu” section of this manual.*

Press the **Enter** button if you wish to check a video after you shoot it. Press the **SNAP** button to begin playback, press it again to pause playback (the display will indicate “AVI PAUSE”). During playback, the counter on the right displays time remaining in the video clip. Press the **Left** arrow key to review previous video or still photo files. When you are ready to return to the live preview display to shoot more videos (or stills), press the **Enter** button.
## LCD Preview Display Icons

<table>
<thead>
<tr>
<th>#</th>
<th>Icon</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Battery Indicator (full battery shown)</td>
</tr>
<tr>
<td>2</td>
<td># of Photos Remaining (based on unused internal or card memory)</td>
</tr>
<tr>
<td>3</td>
<td>Internal or Card Memory</td>
</tr>
<tr>
<td>4</td>
<td>White Balance Setting (Auto White Balance shown)</td>
</tr>
<tr>
<td>5</td>
<td>Exposure Meter Pattern setting</td>
</tr>
<tr>
<td>6</td>
<td>Photo Resolution setting (Pixels)</td>
</tr>
<tr>
<td>7</td>
<td>Photo Quality setting (File Compression)</td>
</tr>
<tr>
<td>8</td>
<td>Self Timer (10 sec delay)</td>
</tr>
<tr>
<td>9</td>
<td>Rapid Sequence (3 shot burst)</td>
</tr>
<tr>
<td>10</td>
<td>Video Mode (Elapsed time counter as shown is visible only during recording)</td>
</tr>
<tr>
<td>11</td>
<td>Digital zoom indicator bar (only visible when digital zoom is in use)</td>
</tr>
</tbody>
</table>

### Additional Feature Icons

Press the **Right** key (1, 2, or 3 times) to select the self timer, rapid sequence, or video mode features. Press once again after selecting video mode to return to normal still photo operation (camera icon returns at top right of LCD).
Using the Main Menu - Options and Settings

As mentioned earlier in this manual, your SyncFocus is already set for high resolution and quality right out of the box. Exposure, white balance, and other variables are set automatically. This means that you will get good results for most subjects and lighting without the need to go into the menu to change any settings. However, you should become familiar with the available options so that you can improve your photos if, for example, you decide they are coming out too dark (common in photos with snow or at the beach), or too green (under some fluorescent lights). Press the MENU button to enter the main menu. Use the Plus/Minus keys to highlight an option within the menu, then press Enter if you wish to change the settings for that option. Use the Plus/Minus keys to select the setting you want, then press Enter to confirm this setting. Here are all the options and settings available in the main menu, along with descriptions of what they do:

<table>
<thead>
<tr>
<th>OPTION</th>
<th>SETTINGS</th>
<th>DESCRIPTION</th>
</tr>
</thead>
<tbody>
<tr>
<td>Resolution (Image Size)</td>
<td>3264x2440 (7.9MP*), 2660x1920 (4.9MP),</td>
<td>Sets the desired still photo resolution in pixels (megapixels). Higher resolution settings produce sharper/larger prints but require more storage space in internal or card memory. Use lower settings to store more in memory, or for email, PC viewing only, etc.</td>
</tr>
<tr>
<td></td>
<td>2048x1536 (3.1MP), 1600x1200 (1.9MP),</td>
<td></td>
</tr>
<tr>
<td></td>
<td>800x600 (0.48MP)</td>
<td></td>
</tr>
<tr>
<td></td>
<td>*7.9MP via software interpolation.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Actual sensor resolution is 4.9MP.</td>
<td></td>
</tr>
</tbody>
</table>

*Note: Default settings are indicated in bold*
Using the Main Menu-Options and Settings

<table>
<thead>
<tr>
<th>OPTION</th>
<th>SETTINGS</th>
<th>DESCRIPTION</th>
</tr>
</thead>
<tbody>
<tr>
<td>Resolution (Video Size)</td>
<td>640x480 30F Loop, 640x480 30F Norm, 640x480 15F Loop, 640x480 15F Norm, 320x240 30F Loop, 320x240 15F Loop, 320x240 15F Norm</td>
<td>“640x480” or “320x240” = resolution in pixels per video frame. Higher resolution = more detail. “30F” or “15F” = frame rate in frames per second. Faster FPS = smoother video. “Loop” or “Norm” = use a Loop setting if you want “Instant Replay” video (automatically starts recording again after 8, 15, 30 or 60 seconds, erasing the previous video). Use “Norm” for a “normal” continuous video, with recording time limited only by available memory (no automatic re-recording).</td>
</tr>
<tr>
<td>Image Quality</td>
<td>Best, Better, Standard</td>
<td>Sets the amount of file compression, which affects the quality of the photo and the size of the file it creates. This can be used independently of Image Size to help store more photos in exchange for slightly reduced quality. “Best” produces the highest quality, but also generates larger files that fill available memory sooner (fewer photos possible).</td>
</tr>
<tr>
<td>EV</td>
<td>-2.0 ~ +2.0 (Default= 0 EV)</td>
<td>Provides manual under/over exposure adjustment in 0.5 EV steps. Minus values produce darker photos, plus values lighter. When a subject is mostly bright (snow scene), you may need to add some “+” EV to avoid underexposure.</td>
</tr>
</tbody>
</table>
### Using the Main Menu - Options and Settings

<table>
<thead>
<tr>
<th>OPTION</th>
<th>SETTINGS</th>
<th>DESCRIPTION</th>
</tr>
</thead>
<tbody>
<tr>
<td>White Balance</td>
<td><strong>Auto</strong>, Daylight, Cloudy, Fluorescent, Tungsten</td>
<td>Sets the reference for neutral white, so that colors are reproduced correctly. If “Auto” does not provide good results, try the setting that matches the light source.</td>
</tr>
<tr>
<td>Meter</td>
<td><strong>Weight</strong>, Center, Average</td>
<td>Sets what area of the image frame is used to determine exposure. “Weight” bases the exposure 60% on the center of the frame, 40% on the rest of the frame. “Center” uses only the center area (good for strong backlit situations), and “Average” averages exposure for the entire frame.</td>
</tr>
<tr>
<td>Language</td>
<td><strong>English</strong>, Spanish, Italian, French, German</td>
<td>Selects preferred language for all menu display screens.</td>
</tr>
<tr>
<td>Auto Off</td>
<td>60 S (1 min), <strong>120 S (2 min)</strong>, Cancel</td>
<td>Sets the interval after the last action (pressing any button) before the camera turns off to conserve battery power. Select “Cancel” to prevent auto shutoff altogether.</td>
</tr>
<tr>
<td>Clock Set</td>
<td>Sets: <strong>YEAR/MONTH/DATE/HOUR/MINUTE</strong></td>
<td>Use the <strong>Plus/Minus</strong> keys to set (in order) the Year, Month, Date, and Hour, Minute, Second. Use the Right key to move to the next field you want to set. <em>See “Date Stamp” also.</em></td>
</tr>
</tbody>
</table>
### Using the Main Menu-Options and Settings

<table>
<thead>
<tr>
<th>OPTION</th>
<th>SETTINGS</th>
<th>DESCRIPTION</th>
</tr>
</thead>
<tbody>
<tr>
<td>Date Stamp</td>
<td>MM/DD/YY, YY/MM/DD, OFF</td>
<td>Use the first two settings if you want the date and time imprinted in the lower right corner of all your photos—you have the option of month first or year first formats. The time will also be included—only 24 hr format is available. To prevent imprinting the date and time, highlight “Off” and press Enter.</td>
</tr>
<tr>
<td>Default Setup</td>
<td>OK, Cancel</td>
<td>Restores all settings for all options to original factory default settings.</td>
</tr>
<tr>
<td>Exit</td>
<td></td>
<td>Select “Exit” and press Enter to exit the Menu and return to the preview (“live” camera) display.</td>
</tr>
</tbody>
</table>

### Using the Review Menu-Options and Settings

Press Enter to enter Review mode. Use the Left arrow key to go back through the stored photos/videos. Once you are in review mode, pressing the MENU button will enter the review menu. This operates in the same way previously described in the main menu system instructions (use the Plus/Minus and Up/Down arrow keys to navigate to the desired menu option and settings, press Enter to confirm a setting), but with different menu items as shown in the following table:
<table>
<thead>
<tr>
<th>OPTION</th>
<th>SETTINGS</th>
<th>DESCRIPTION</th>
</tr>
</thead>
<tbody>
<tr>
<td>Delete One</td>
<td>OK, Cancel</td>
<td>Highlight “OK” and press Enter to delete the currently displayed photo or video. If pressed accidently, highlight “CANCEL” and press Enter.</td>
</tr>
<tr>
<td>Format</td>
<td>OK, Cancel</td>
<td>Same as above except deletes entire contents of internal or card memory. When an SD card is inserted that has been used previously in other devices, formatting it before starting to take photos is recommended (be sure any files you want to keep have been downloaded and backed up first). Can also be used anytime to quickly delete all photos instead of one at a time. When all photos have been deleted, the display will show “Sorry-no picture”.</td>
</tr>
<tr>
<td>Protect</td>
<td>Lock, Unlock</td>
<td>Highlight “Lock” and press Enter to protect the currently displayed photo or video from accidental erasure (unless Format is used to delete entire contents of memory). Highlight “Unlock” and press Enter to allow deleting a previously protected photo or video.</td>
</tr>
</tbody>
</table>

The Review Menu Options after “Protect” (Language, Auto Off, etc.) are the same as those after “Meter” in the Main Menu, and perform the same functions as previously described in “Using the Main Menu”.
TRANSFERRING THE PHOTOS & VIDEOS TO YOUR PC

1. Turn on the SyncFocus (press ON/OFF). Connect the supplied cable to the USB port (I) below the SD card slot on the SyncFocus (pull down the rubber cover flap-please refer to the “Camera and Binocular Parts Guide” page), then connect the other end directly to a main USB port on your computer-do not use front panel/keyboard USB ports or unpowered “hubs”.

2. The LCD display will indicate “MASS STORAGE”, and the ImageView will be recognized as a standard “USB Mass Storage” device. This means that the camera files can be easily viewed, edited, or copied to your hard drive, just as if they were stored on an external hard drive or a CD-ROM.

3. (This step is not required with Windows XP, simply use the options in the pop-up window to view, copy or edit your photos). Open My Computer or Windows Explorer. The camera will be seen as a new “Removable Disk” with an unused drive letter assigned to it. Double click this new “Disk” icon, open the “DCIM” folder inside, then the folder(s) inside that (“100MEDIA”, etc). Your photos/videos are the files inside-they have the prefix “PICT__” followed by a number, same as seen earlier on the camera’s display when you review photos. Double click a file to view it full screen, or select the “Filmstrip” or “Thumbnail” options from the View menu of the open window.

4. Click “Edit>Select All” in the Windows menu (or click on one photo, control+click to select multiple photos), then “Edit>Copy to Folder” (in Windows menus). Select an existing folder on your hard drive, such as “My Pictures”, or create a new folder (“Hawaii Vacation”, etc), then click “OK” to transfer copies of the photo files you want.
5. After the photos are transferred to your computer, you can disconnect the SyncFocus. Windows 2000 may produce a screen warning that you have disconnected a USB device without stopping or ejecting the “disk” first (your photo files will not be harmed). If so, check the box that adds an icon to your system tray or taskbar. Then next time you finish transferring photos, you can click that icon first, and “Stop the USB Mass Storage Device” before disconnecting the camera. (On Mac computers, you should “eject” the “disk” that appeared on your desktop when the camera was connected—you can simply drag it to the Trash to eject it.)

*Note: If your PC will not play the .avi movie files in Windows Media Player, you may need to download a newer version of Media Player or Direct X from Microsoft.com. The movie files can also be played back with the QuickTime Player, included with many computers, or available as a free download from Apple.com.*

6. You’re now ready to open the photo files in any photo editing software. Just use File>Open and go to the folder where you stored the photos earlier. It is also possible to open and work with your photos directly from the ImageView while it is still connected. If you choose to work this way, from a connected camera, be sure that you save the photo (when you are done editing) to your hard drive, and not the camera’s memory or card.

7. If you are new to photo editing on a computer, consult your software’s Help menu or manual for tips on using its features. Along with adjusting the brightness, contrast, sharpness and color of your photos, you can resize the photo to fit the paper if you are printing, or save a smaller, low or medium resolution version for email or inserting into documents. When you are ready to save your edited file, you may want to use “Save As” and give it a more descriptive name than “PICT___”. Doing this also preserves the original file as a backup to reopen and re-edit later. Make sure you have successfully transferred all the photos you wanted to save before using “Format” on your camera to make room for new images.
TWO-YEAR LIMITED WARRANTY

Your Bushnell® product is warranted to be free of defects in materials and workmanship for two years after the date of purchase. In the event of a defect under this warranty, we will, at our option, repair or replace the product, provided that you return the product postage prepaid. This warranty does not cover damages caused by misuse, improper handling, installation, or maintenance provided by someone other than a Bushnell Authorized Service Department.

Any return made under this warranty must be accompanied by the items listed below:

1) A check/money order in the amount of $10.00 to cover the cost of postage and handling
2) Name and address for product return
3) An explanation of the defect
4) Proof of Date Purchased
5) Product should be well packed in a sturdy outside shipping carton, to prevent damage in transit, with return postage prepaid to the address listed below:

IN U.S.A. Send To:
Bushnell Outdoor Products
Attn.: Repairs
8500 Marshall Drive
Lenexa, Kansas 66214

IN CANADA Send To:
Bushnell Outdoor Products
Attn.: Repairs
25A East Pearce Street, Unit 1
Richmond Hill, Ontario L4B 2M9

For products purchased outside the United States or Canada please contact your local dealer for applicable warranty information. In Europe you may also contact Bushnell at:

Bushnell Germany GmbH
European Service Centre
Mathias-Brüggen-Straße 80
D-50827 Köln
GERMANY
Tel: +49 221 995568-0
Fax: +49 221 995568-20

This warranty gives you specific legal rights.
You may have other rights which vary from country to country.
©2010 Bushnell Outdoor Products

FCC Compliance Statement:
This equipment has been tested and found to comply with the limits for a Class B digital device, pursuant to part 15 of the FCC Rules. These limits are designed to provide reasonable protection against harmful interference in a residential installation.

Operation is subject to the following two conditions: (1) This device may not cause harmful interference, and (2) this device must accept any interference received, including interference that may cause undesired operation.

This equipment generates, uses and can radiate radio frequency energy and, if not installed and used in accordance with the instructions, may cause harmful interference to radio communications. However, there is no guarantee that interference will not occur in a particular installation. If this equipment does cause harmful interference to radio or television reception, which can be determined by turning the equipment off and on, the user is encouraged to try to correct the interference by one or more of the following measures:

· Reorient or relocate the receiving antenna.
· Increase the separation between the equipment and receiver.
· Connect the equipment into an outlet on a circuit different from that to which the receiver is connected.
· Consult the dealer or an experienced radio/TV technician for help.

The device does not contain any user-serviceable parts. Repairs should only be made by an Authorized Bushnell repair center. Unauthorized repairs or modifications could result in permanent damage to the equipment, and will void your warranty and your authority to operate this device under Part 15 regulations.

The shielded interface cable which is provided must be used with the equipment in order to comply with the limits for a digital device pursuant to Subpart B of Part 15 of FCC Rules.

Specifications and designs are subject to change without any notice or obligation on the part of the manufacturer.
For further questions or additional information please contact:

Bushnell Outdoor Products
9200 Cody, Overland Park, Kansas 66214
(800) 423-3537 • www.bushnell.com

©2010 Bushnell Outdoor Products